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Minimum System Requirements

Operating System: Windows 2000 SP4, XP SP2, Vista, 7, 8

Memory: 128MB RAM 

Hard Drive: 100MB 

Additional Requirements: IT Administrator Privileges

Supplies
DuraLabel supplies and DuraLabel® PRO printers have been optimized for compatibility 
and print quality. Use only DuraLabel supplies from Graphic Products with your 
DuraLabel PRO/PRO 300 printer. 

NOTE: The DuraLabel PRO/PRO 300 User Guide includes information for both the 
DuraLabel PRO and DuraLabel PRO 300 printers. Reference to “DuraLabel PRO” 
implies either the DuraLabel PRO or DuraLabel PRO 300 printer.

Copyright Information
No part of this guide, including the products and software described in it, may be 
reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any 
language in any form or by any means, except as documentation kept by the purchaser 
for backup purposes, without the express written permission of Graphic Products, Inc.

Products and corporate names appearing in this guide may or may not be registered 
trademarks or copyrights of their respective companies, and are used only for 
identification or explanation and to the owners’ benefit, without intent to infringe.

Specifications and other content contained in this guide are furnished for informational 
use only and are subject to change at any time without notice, and should not be 
construed as a commitment by Graphic Products. Graphic Products assumes no 
responsibility or liability for any errors or inaccuracies that may appear in this guide.
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Introduction
Congratulations on the purchase of your DuraLabel® PRO/PRO 300 Printer.

You’ll be printing pipe markers, arc flash, NFPA Diamond, GHS, right-to-know, barcodes, 
and custom labels in no time with your new DuraLabel Printer.

Call us at 800.788.5572 with any questions you may have about your DuraLabel PRO/
PRO 300 printer. We’re here to help with all your labeling needs!



2 | Contents   DuraLabel.com | 800.788.5572

Contents
1. Warranties   4

1.1 5-Year DuraLabel Printer Warranty   4
1.1.1 Repairs   4
1.1.2 Batteries   4
1.1.3 Warranty Details   4

1.2 5-Year DuraLabel Premium Vinyl Warranty   5

2. Loading the Printer   6
2.1 Printer Parts   6
2.2 Printer Ribbon Parts   7
2.3 Loading Ribbon   8

2.3.1 Loading 4.3" ribbon supply   8
2.3.2 Loading 2.5" ribbon supply   11

2.4 Loading Vinyl Supply   12
2.5 Installing Tape Guides   14

3. Connecting the Printer   17
3.1 Inserting the Installation CD   17
3.2 Using a USB Cable   17
3.3 Using a Parallel Cable   20
3.4 Upgrading a Driver  22 

4. Configuring Printer Drivers   23
4.1 Continuous Vinyl Printing Instructions   23
4.2 Die-Cut Label Printing Instructions   24

4.2.1 Label Supply Calibration   24
4.2.2 Driver Settings   25

4.3 B Mark Label Printing Instructions   25
4.3.1 Label Supply Calibration   25
4.3.2 Driver Settings   25

4.4 Cutting Labels in Intervals   26
4.5 Adjusting Print Speed   26
4.6 Adjusting Darkness   26

5. Installing Labeling Software   27
5.1 DuraSuite Labeling Software   27
5.2 LabelForge Labeling Software   27

6. Label Creation   28
6.1 Label Creation with Your Word Processor   28

6.1.1 Using Templates   28
6.1.2 Setting up a Microsoft Word Document   29

7. Label Design   30
7.1 Text Boxes   30

7.1.1 Changing Text Box Size   30 
7.1.2 Positioning Text Boxes   31

7.2 Graphics   32
7.3 Merging Information, Sequencing Labels   33

7.3.1 Creating an Excel Spreadsheet   33



DuraLabel.com | 800.788.5572    Contents | 3

CONTENTS

8. Cleaning and General Maintenance   38
8.1 Print Head   39
8.2 Cutter   39

8.2.1 Cleaning Cutter from the Inside   39
8.3 Platen Roller   41

9. Troubleshooting   42
9.1 LED is Solid Red   42
9.2 Printing Suddenly Stops and LED Blinks Red   42
9.3 LED Quickly Blinks Red   42
9.4 Printing Stops While Printing Die-cut Labels and LED Blinks Red   43
9.5 LED Blinks Green after Label is Printed   43
9.6 After Printing a Label, Printer Dispenses Extra Supply and LED Blinks Red   43
9.7 Printing is not Aligned Correctly   43
9.8 Printing is Streaked   44
9.9 LED Blinks Amber and Red   44
9.10 Printer Cuts Labels Off-Center or into Next Label   45

10. Specifications   46
10.1 Printer   46
10.2 Indicators and Buttons   46
10.3 Communication Interface   46
10.4 Power Requirements   46
10.5 Environment   46
10.6 Label Supply   47
10.7 Ribbon Supply   47
10.8 Printer Body   47



4 | 1.1 5-Year DuraLabel Printer Warranty   DuraLabel.com | 800.788.5572

1. Warranties

1.1 5-Year DuraLabel Printer Warranty
Graphic Products’ DuraLabel printers are warrantied to be free from 
defects in materials and workmanship for a period of five (5) years 
from the date of purchase. Within this period, Graphic Products, Inc. 
will, at its sole option, repair or replace any components which fail in 
normal use. Such repairs or replacement will be made at no charge to the purchaser for 
parts or labor, provided that the purchaser shall be responsible for any transportation 
cost. This warranty does not cover loss, damages from accident, or equipment or parts 
which have been misused, altered, neglected, carelessly handled, used for purpose 
other than those for which the printer was manufactured, or damages resulting from 
unauthorized service.

1.1.1 REPAIRS
Repairs are warrantied for 90 days. If the original warranty is still in effect, repaired 
units will remain under their original warranty or for 90 days from the date of service, 
whichever is longer.

1.1.2 BATTERIES
The optional battery packs for the DuraLabel Toro and Lobo portable systems are 
warrantied for three years from the date of purchase.

The battery for the DuraLabel 2000 PLUS system is warrantied for one year from the 
date of purchase.

1.1.3 WARRANTY DETAILS
The warranties and remedies contained herein are exclusive and in lieu of all other 
warranties whether express, implied, or statutory, including any liability arising under any 
warranty of merchantability or fitness for a particular purpose, statutory or otherwise. 
This warranty gives the purchaser specific legal rights, which may vary from state to 
state.

In no event shall Graphic Products be liable for any incidental, special, indirect, or 
consequential damages, whether resulting from the use, misuse, or inability to use 
the product for any reason including defect. Some states do not allow the exclusion of 
incidental or consequential damages, so the above limitation may not apply in all areas.

Graphic Products retains the exclusive right within all warranty periods to repair, replace, 
or offer a full refund of the purchase price at its sole discretion. Such remedy shall be 
the purchaser’s sole and exclusive remedy for any breach of warranty.
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WARRANTIES

General maintenance and cleaning of the DuraLabel printer is the purchaser’s 
responsibility and is not covered by the warranty. Expendable items or parts such as 
label supply and ribbon are not covered by this warranty.

NOTE:
Graphic Products representative to ensure correct return procedure: please call 
800.788.5572 for details. Graphic Products, Inc. shall not be responsible for any loss 
or damages incurred during shipping.

1.2 5-Year DuraLabel Premium Vinyl Warranty
DuraLabel supplies are tested for durability under various conditions, including UV 
exposure, moisture, heating and cooling cycles, abrasion, and chemical exposures. 
Graphic Products warranties labels made from its Premium vinyl supplies for a period of 
five (5) years. 

Within five years of purchase and after proper application, Graphic Products will replace 
labels made with DuraLabel Premium Vinyl which become unreadable or fail to maintain 
adhesion with the labeled surface.  In such instance, Graphic Products, Inc. will provide 
a one-time replacement roll of the same supply.
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2. Loading the Printer
DuraLabel Ribbon and Vinyl Supplies have been optimized for compatibility and print 
quality. Only authorized DuraLabel Supplies from Graphic Products will print correctly in 
the DuraLabel PRO/PRO 300 printer.

An instructional video demonstrating how to load DuraLabel Ribbon and Supplies can be 
viewed at DuraLabel.com/duralabel-videos.

2.1 Printer Parts

A

B

D

F

G

H

I

C

E

Figure 1 Inside of printer, with ribbon mechanism open in upright position

A. Supply loading diagram

B. Label supply roll

C. Label roll mounts

D. Fixing tabs

E. Teflon bar (white)

F. Adjustable label guides (turquoise)

G. Media sensor/B Mark sensor 
(turquoise)

H. Platen roller (black)

I. Printed label opening
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LOADING THE PRINTER

2.2 Printer Ribbon Parts

Rear Spring-Loaded Hub
for Ribbon Supply Spindle

Rear Hub for Flange Side of 
Ribbon Supply Spindle

Front Hub for Flange Side of 
Ribbon Rewind Spindle

Front Spring-Loaded Hub 
for Ribbon Rewind Spindle 
(with paper core)

LoL aded Hub for FlangeFigure 1

NOTE:
diagram under the ribbon supply.

Ribbon Spindle Flange

Ribbon Rewind Spindle
with Paper Core Applied

Ribbon Supply Spindle

Figure 2
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LOADING THE PRINTER

2.3 Loading Ribbon

IMPORTANT! Always turn the printer OFF when loading supplies. Always wait at least 5 
seconds before turning power back ON.

Open the ribbon mechanism cover by pressing down and in to unlatch it, then lift it up 
and back to open.

NOTE: To load 4.3" ribbon, follow the instructions in section 2.3.1. To load 2.5" ribbon, 
follow instructions in section 2.3.2.

2.3.1 LOADING 4.3" RIBBON SUPPLY
A. With spindle flange on right side, load ribbon onto an empty ribbon supply spindle, 

with the ribbon leader extended over the top and toward the back.

B. Slide the ribbon onto the spindle until it touches the spindle flange.

C. Apply the paper core to the other empty ribbon rewind spindle. 

D. Apply the ribbon supply spindle to the rear hub, with the ribbon leader dropped 
down. Insert the left side of the spindle first, fitting it onto the left hub, then fitting 
the right (flanged) side onto the right hub.

Figure 1 Press down and in to unlatch. Figure 2 Lift up and back to open.

Ribbon Leader

Spindle Flange

Figure 3 Correct ribbon application for spindle
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LOADING THE PRINTER

E. Place the ribbon rewind spindle (with paper core) on the front hubs by inserting the 
left side of the spindle first, fitting it onto the front spring-loaded hub. Then fit the 
right (flanged) side of the spindle onto the right hub.

F. Open the printer cover by pulling 
the release levers on the sides of 
the printer toward you.

Figure 7 Ribbon supply (4.3") spindle being inserted 
at rear hubs

Figure 8 Ribbon supply (4.3") spindle inserted at rear hubs

Figure 9 Ribbon rewind spindle with paper core (4.3") being applied to the front spring-loaded hub

Figure 10   
Ribbon supply 
(2.5") spindles 
loaded and aligned 
with each other

Figure 11 Printer release lever being pulled forward
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LOADING THE PRINTER

G. Grab the ribbon leader that is hanging down.

H. Pull it toward you and underneath the ribbon mechanism and print head, up to the 
front hub and ribbon rewind spindle.

NOTE: The ribbon should rotate with ease as you unroll it. 

I. Tape the entire width of the end of the ribbon leader to the ribbon rewind spindle’s 
paper core, placing one piece of tape horizontally.

J. Roll the ribbon rewind spindle (top side of spindle moving away from you) to secure 
the ribbon supply and eliminate wrinkles, fingerprints or flaws. Your ribbon supply 
should now be loaded.

NOTE: The ribbon-loading process is the same for all ribbon sizes in steps D – J. 
Figures 7, 8, 9, 12, 13, 14 and 15 illustrate 4.3" ribbon supply.

Figure 12 Ribbon supply (4.3") being pulled down
Figure 13 Ribbon supply (4.3") being pulled up to the ribbon 
rewind spindle

Figure 14 Ribbon supply (4.3") taped to ribbon rewind 
spindle Figure 15 Ribbon supply (4.3") rolled tight
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LOADING THE PRINTER

2.3.2 LOADING 2.5" RIBBON SUPPLY
A. With spindle flange on the right side, load ribbon onto the ribbon supply spindle, 

with the ribbon leader extended over the top and toward the back.

B. Align the ribbon supply in the center of the ribbon spindle using the measurement 
marks.

C. Apply the paper core to the ribbon rewind spindle, centering it using the 
measurement marks. 

Now refer to Steps D – J under “Loading 4.3" ribbon supply.” 

Figure 5 Ribbon supply (2.5") 
centered on ribbon supply spindle

Figure 6 Paper core (2.5") 
centered on ribbon rewind 
spindle

Ribbon Leader
Spindle Flange

Figure 4 Correct ribbon application for spindle
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LOADING THE PRINTER

2.4 Loading Vinyl Supply

IMPORTANT! Always turn the printer OFF when loading supplies. Always wait at least 5 
seconds before turning power back ON.

A. Load the vinyl supply onto the label supply spindle, centering and securing it with 
the fixing tabs located on each end.

B. Place loaded label supply spindle into the label roll mount slots, with the label 
supply extending over the top of the roll and toward the front of the printer.

C. Lead the label supply underneath the 
white Teflon bar, over the platen roller 
and through the printed label opening, 
leaving at least ½" of supply extended 
out to help prevent loading errors.

D. Move the adjustable label guides to hold the label supply in place.

Figure 1 Loaded label supply spindle set in label roll  
mount slots

Figure 2 Label supply loaded in the correct direction

Figure 4 Label supply held in place by adjustable label guides

Figure 3 Label supply loaded correctly, with printable 
surface facing up and liner facing down
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LOADING THE PRINTER

E. Close the printer cover by slowly lifting up, then pressing down until it  
latches shut.

F. Close the ribbon mechanism cover by pressing down and in until it latches shut. 
Your printer is now loaded and ready to print.

Figure 5 Lift printer cover all the way up,  
then press down until it latches shut.

Figure 6 Printer cover closed, with ribbon 
mechanism cover open

Figure 7 Press down and in to close. 

Figure 8 Loaded DuraLabel PRO 300 printer, ready to print
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LOADING THE PRINTER

2.5 Installing Tape Guides
Tape guides are required for ½" label supply and shrink tube sizes ½" and smaller. 
Larger vinyl and shrink tube supply are held in place by the adjustable label guides.

A. Load shrink tube or ½" label supply and thread it through the cutter.

B. Find the tape guide to match the size of label or shrink tube supply loaded in your 
printer.

Left Adjustable Label Guide

Right Adjustable 
Label Guide

Figure 1 Loaded shrink tube supply

1/2"1/8" 3/16" 1/4" 3/8"

Figure 2

1/2"  
Shrink Tube

Figure 3 Tape guide, with cutout opening facing 
up, toward supply spindle

Figure 4 Tape guide showing grooved section  
(Tape guide is shown upside down.)

Cutout Opening Grooved Section
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LOADING THE PRINTER

C. While facing the front of the printer, hold the tape guide with the grooved side 
facing down and the cutout opening facing up.

D. Slip the cutout opening into the left adjustable label guide, opening slightly. Do not 
press all the way into place.

NOTE: You may need to move the supply slightly to allow it to move freely in the 
grooved section of the tape guide.

E. Align the label supply under the tape guide, fitting it in the grooved section and 
then pressing the tape guide into place.

Figure 5 Position tape guide with grooved section facing down

grooved section.

Figure 7 Align supply in the grooved section for easy movement.



16 | 2.5 Installing Tape Guides   DuraLabel.com | 800.788.5572

LOADING THE PRINTER

F. Move the adjustable label guides toward each other until the tape guide touches 
the right adjustable label guide and the label guides cannot move any further.

G. The label supply should now be aligned over the media sensor. If it isn’t, slide the 
media sensor to center it beneath the supply.

H. Close the printer cover and you’re ready to print.

Figure 9 Adjustable label guides pressed together

Figure 10 Supply aligned under tape guide and over media sensor
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3. Connecting the Printer
Connect the power supply from the DuraLabel PRO/PRO 300 printer to an electrical 
outlet. Next, connect the USB or parallel cable from the DuraLabel PRO to your PC, then 
power ON your printer.

3.1 Inserting the Installation CD
Before inserting the installation CD, please refer to the specific instructions for the type 
of cable you’re using. When using a USB cable, follow instructions in Section 3.2, Using 
a USB Cable. When using a parallel cable, follow instructions in Section 3.3, Using a 
Parallel Cable.

NOTE:
the print driver and printer. Refer to Section 4.2, Die-Cut Label Printing Instructions, 
or Section 4.3, B Mark Label Printing Instructions.

3.2 Using a USB Cable

NOTE: You may need IT administrator privileges to install a driver.

NOTE: The following instructions are only for those using a USB cable. Skip to Section 
3.3, Using a Parallel Cable, if installing manually.

A. Insert the DuraLabel PRO or DuraLabel 
PRO 300 Installation CD in your 
computer’s disk drive. A DuraLabel 
PRO/PRO 300 startup screen appears.

NOTE: If the CD does not run automatically, 
go to Start > Computer and double-click on 
your CD/DVD drive, which should show the 
DL icon.

B. Click on Driver Wizard, then click Next in the Driver Wizard setup window that 
appears.

C. Click I Agree on the Windows Printer Driver License Agreement window that 
appears.

Figure 1 DuraLabel PRO 300 startup screen
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CONNECTING THE PRINTER

D. Select DuraLabel PRO or DuraLabel PRO 300 and click Next on the DuraLabel 
Driver Selection window that appears.

E. Choose the install location and click Install on the Choose Install Location window 
that appears. An Installing window shows installation progress.

F. Select Install printer drivers* on the Driver Wizard 
window that appears and click Next.

*NOTE: You will receive a notice if a previous driver is 
found that should be removed. Please refer to Section 
3.4, Upgrading a Driver, for instructions on uninstalling 
a driver.

G. A Plug and Play Detection window appears. 
Highlight Graphic Products DuraLabel PRO or 
DuraLabel PRO 300 and click Next. 

FIGURE 2  DuraLabel Driver Setup Wizard FIGURE 3 Windows Printer Driver 
License Agreement

FIGURE 4  Selecting a DuraLabel Driver 

FIGURE 5 Driver Install Location Window

 FIGURE 6 Installing Window

FIGURE 7 Install Printer Driver Window

FIGURE 8 Install Driver for a Plug and 
Play Printer
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CONNECTING THE PRINTER

NOTE: Windows 8 users, do not select the listed printer. Instead, check Install a 
driver for another printer and click next. Select Graphic Products DuraLabel Pro or 
DuraLabel Pro 300 and click next. Select the appropriate port and click next.

H. Enter Printer Name and set it as the default 
printer, if you choose, by checking the adjoining box 
in the Specify Printer Name window that opens. 
Choose a sharing option, then click Next.

I. Review information on the Completing the Seagull 
Driver Wizard window that appears. Click Finish 
if the information is correct. If it isn’t, correct 
previous selections and click Finish when the 
information is correct.

J. A Driver Wizard Completed Successfully window appears, confirming the printer 
driver installation was completed successfully. Now click Close.

K. The previous window closes and a Completing the DuraLabel Driver Setup Wizard 
window appears. Click Finish to complete the new driver installation. 

Select printer model Select the appropriate portFor Windows 8 systems, select Install a 
driver for another printer  

FIGURE 10 Completing the Seagull Driver 
Wizard

FIGURE 11 Driver Wizard Completed 
Successfully Window

FIGURE 12 Click Finish on the Completing 
the DuraLabel Driver Setup Wizard 
window. The driver installation is now 
complete.

FIGURE 9  Specify Printer Name, Default 
and Sharing Status  
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CONNECTING THE PRINTER

3.3 Using a Parallel Cable

NOTE: You may need IT administrator privileges to install a driver.

The following instructions are only for those using a parallel cable:

A. Insert the DuraLabel PRO or DuraLabel PRO 300 
Installation CD in your computer’s disk drive. A 
DuraLabel PRO/PRO 300 startup screen appears.

NOTE: If the CD does not run automatically, go to Start > 
Computer and double-click on your CD/DVD drive, which 
should show the DL icon.

B. Click on Driver Wizard, then click Next on the new Driver Wizard window.

C. Click I Agree on the Windows Printer Driver License Agreement window that 
appears.

D. Select DuraLabel PRO or DuraLabel PRO 300 and click Next on the 
DuraLabel Driver Setup window that appears.

E. Choose the install location and click Install on the Choose Install Location 
window that appears. An Installing window shows installation progress.

FIGURE 1 DuraLabel PRO 300 Startup 
Screen

FIGURE 2  DuraLabel Driver Setup Wizard FIGURE 3 Windows Printer Driver License 
Agreement

FIGURE 4 Selecting a DuraLabel Driver 

FIGURE 5 Driver Install Location Window 

FIGURE 6 Installing Window

FIGURE 7 Install Printer Driver Window
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CONNECTING THE PRINTER

F. Select Install printer drivers on the Driver Wizard window that appears and 
click Next.

G. Select Graphic Products DuraLabel PRO or DuraLabel PRO 300 on the Specify 
Printer Model window that appears and click Next.

H. Select the LPT1 port on the Specify Port window that appears and click Next.

I. Select Printer Name, set the printer as default, and choose printer sharing 
options on the Specify Printer Name window that opens, then click Next.

J. Review information on the Completing the Seagull Driver Wizard window that 
opens and click Finish if the information is correct. If it isn’t correct, revise the 
selections made in previous steps and click Finish when the window’s information 
is accurate.

K. A Driver Wizard Completed Successfully window appears, confirming the printer 
driver installation was completed successfully. Click Close.

L. The previous window closes and a Completing the DuraLabel Driver Setup Wizard 
window appears. Click Finish to complete the new driver installation. 

FIGURE 8  Specify Printer Model for 
Driver Installation.

FIGURE 9 Select LPT1 port when using a 
parallel cable to install a driver.

FIGURE 10 Printer Name, Default and 
Sharing Status  

FIGURE 12 Driver Wizard Completed 
Successfully Window

FIGURE 11 Completing the Seagull 
Driver Wizard 

FIGURE 13 Click Finish on the Completing 
the DuraLabel Driver Setup Wizard window. 
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CONNECTING THE PRINTER

3.4 Upgrading a Driver
If you’re upgrading from a previously installed driver, follow these steps to uninstall the 
previous driver:

A. Insert the installation CD.

B. Press the Uninstall Driver button on the installation screen.

C. Click Remove printer drivers, then click Next.

D. Click Use advanced printer driver removal options, then click Next.

E. Check all existing DuraLabel printers, then click Next.

F. Check all existing DuraLabel drivers, then click Next.

G. Check all existing DuraLabel components, then click Next.

H. Check the files associated with the deleted items you wish to remove, then click 
Next.

I. Review the list provided, then click Finish.

J. Click Restart.

The new DuraLabel PRO printer driver may now be installed.

NOTE: If upgrading from an older driver, you may need to restart your computer during 
installation of the new driver.
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IMPORTANT! 
to print.

A. Click Start > Devices and Printers*. A Devices, Printers and Faxes window 
appears.

*NOTE:  
  it in your Control Panel.

B. Right-click the Graphic Products DuraLabel PRO/PRO 300 icon and select 
Printing preferences. A Printing Preferences dialog box appears.

C. Click the Page Setup tab and select Landscape or 
Portrait, depending on your label’s orientation.

D. If your label size is not shown in the Stock Name 
drop-down menu, click Edit and set the size that 
matches your label size.

NOTE: Your DuraLabel PRO/PRO 300 print drivers are 
preset to several print values. Please be aware that 
changing a preset value is not fully supported by all 
software programs. For best results, make changes to 
preset values from the Devices and Printers window.

4.1 Continuous Vinyl Printing Instructions
Your printer driver has been preset to common settings to reduce the steps needed to 
set them manually. You can change your settings by following these steps:

A. To configure the driver, set the cutter, select the Stock tab, then select Continuous 
from the Type drop-down menu under “Media Settings.”

B. To cut after each label, select Cut from the Post-Print Action drop-down menu and 
select After Every Page from the Occurrence drop-down menu.

C. To cut after each job, select Cut from the Post-Print Action drop-down menu and 
select After Job from the Occurrence drop-down menu.

D. Click Apply,  then OK.

FIGURE 1 Printing Preferences dialog 
box with Page Setup tab selected
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CONFIGURING PRINTER DRIVERS

These settings may be adjusted in Printer Properties* when printing your labels.

*NOTE: This will show as Preferences if accessing File > Print from DuraSuite Labeling 
Software.

4.2 Die-Cut Label Printing Instructions

4.2.1 LABEL SUPPLY CALIBRATION
Label supply must be calibrated to print die-cut labels.

A. With the power OFF, hold the Feed button down while turning ON the printer. The 
LED will flash red 5 times, amber 5 times, green 5 times, alternating green and 
amber 5 times, alternating red and amber 5 times and then turn solid green.

B. Release the Feed button while the LED blinks red and amber.

C. Follow directions in Section 4.2.2, Driver Settings.

FIGURE 2 Printing Preferences dialog 
box, with Type set to “Continuous” and 
Occurrence set to “After Every Page” on the 
Stock tab

FIGURE 3 Set the Printing Preference 
Occurrence menu to “After Job” to print 
multiple labels on a single length of supply.
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CONFIGURING PRINTER DRIVERS

4.2.2 DRIVER SETTINGS
Your printer driver has been preset to reduce the number 
of steps to be completed manually. You can change your 
settings by following these steps:

A. For die-cut labels, select Labels With Gaps from the 
Type drop-down menu.

B. Set Gap Height to 0.12 inches and Gap Offset to 0 
inches (default).

C. Click Apply, then OK.

4.3 B Mark Label Printing Instructions

4.3.1 LABEL SUPPLY CALIBRATION
Label supply must be calibrated to print B Mark labels.

A. With the power OFF, hold the Feed button down while turning ON the printer. The 
LED will flash red 5 times, amber 5 times, green 5 times, alternating green and 
amber 5 times, alternating red and amber 5 times and then turn solid green.

B. Release the Feed button while the LED blinks green and amber.

C. Follow directions in Section 4.3.2, Driver Settings.

4.3.2 DRIVER SETTINGS
Your printer driver has been preset to reduce the number 
of steps to be completed manually. You can change your 
settings by following these steps:

A. For B Mark labels, select Labels With Marks from the 
Type drop-down menu.

B. Set Mark Height to 0.12 inches and Mark Offset to 
0 inches (default).

C. Click Apply, then OK.

FIGURE 4 Printing Preferences dialog 
box, with Type set to “Labels With Gaps”

FIGURE 5 Printing Preferences dialog 
box, with Type set to “Labels With Marks”
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CONFIGURING PRINTER DRIVERS

4.4 Cutting Labels in Intervals
To cut labels in intervals, set “Occurrence” to After Specified Interval. Set the interval to 
the number of labels needed, then click Apply to save your settings.

4.5 Adjusting Print Speed
Choose print speed from the Options tab, clicking on the arrow to the right of the Print 
Speed drop-down menu. A 2” per second setting is recommended.

4.6 Adjusting Darkness
Change darkness settings from the Options tab, dragging the slider on the Darkness 
bar (see Figure 7). Darkness can be adjusted in single increments from 0 – 15. Keep 
the Graphics Format settings on Automatic.

When satisfied with all your settings, click Apply, then OK. Your driver is now set up and 
ready to create labels.

NOTE: You may need to change print settings to optimize the DuraLabel PRO/PRO 300 
for printing with some ribbons and specialty supply. Higher speeds generally require 
higher densities. If a ribbon wrinkles, lower the darkness. Increase darkness to ensure 
all ink is being transferred from the ink ribbon.

FIGURE 6 Printing Preferences dialog box, 

Interval”

FIGURE 7 Printing Preferences dialog box, 
with Options tab selected

RECOMMENDED DARKNESS SETTINGS FOR RIBBON: (PRINT SPEED SET AT 2)

Ribbon Petroleum
Resistant

Standard 
Black White Red Blue Green Orange Shrink

Tube/RTK
Die-Cut 
Labels

Darkness 9-15 4-8 4-8 4-8 4-8 4-8 4-8 6-8 10-13

FIGURE 8 Adjust darkness settings to match your ribbon type and your printing needs.
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5. Installing Labeling Software

5.1 Installing DuraSuite Labeling Software 
DuraSuite Labeling Software lets you create professional-quality pipe markers and arc 
flash, NFPA Diamond, RTK, GHS and custom labels, quickly and easily. To install, from 
the DuraLabel PRO/PRO 300 startup screen, click on DuraSuite Label Software and 
follow the directions that appear. Refer to the DuraSuite Labeling Software User Guide 
for additional information. 

NOTE: You may need IT administrator privileges to perform this installation.

5.2 Installing LabelForge Labeling Software 
LabelForge Labeling Software lets you design your own custom labels and signs and 
includes barcode creation tools for 2D and linear barcoding. 

To install, from the DuraLabel PRO/PRO 300 startup screen, click on LabelForge 
Label Software and follow the directions that appear. Refer to the LabelForge Labeling 
Software User Guide for additional information. 

NOTE: You may need IT administrator privileges to perform this installation.
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6. Label Creation
This section describes how to create labels using Microsoft® Word. Variations may occur 
among different versions of Word, but basic principles are the same. The DuraLabel 
PRO/PRO 300 is designed to work with any currently supported Windows software and 
should work with the software installed on your computer. Microsoft Word 2003 and 
2010 were used to describe many procedures in this Guide. 

NOTE: Navigation may vary depending on your version of Word, but the tools will be the 
same.

The information in this section assumes your printer has been properly installed and is 
connected in the online mode.

6.1 Label Creation with Your Word Processor
DuraLabel PRO/PRO 300 printers operate off a standard Windows driver that allows 
access to a wide variety of software packages.

6.1.1 USING TEMPLATES

IMPORTANT! If you do not follow this step, you will need to create all labels from 
scratch.

The DuraLabel PRO/PRO 300 provides a variety of templates you can install from the 
installation CD start-up screen. Click on Install Templates & Symbols and follow the 
instructions. When installation is complete, templates and symbols will be accessible from 
a folder titled My Documents\DLP Templates & Symbols.

To use a template, open Microsoft Word, select Open and browse the DLP Templates 
& Symbols folder. Any template you choose has been set up to print correctly on the 
DuraLabel PRO/PRO 300 printer with minimal augmentation.
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LABEL CREATION

6.1.2 SETTING UP A MICROSOFT WORD DOCUMENT
When opening a document, change size and margins to match your label’s size. (Word 
processors default to 8.5" x 11".) Click on the File menu, then Page Setup. Click the 
Margins tab on the Page Setup dialog box that appears. Set all Margins to 0 to print on 
the entire supply.

Set Orientation to Portrait if label width is the same dimension as the supply width 
loaded in your printer. Set orientation to Landscape if label height is the same as the 
supply width loaded in your printer. Click OK when done.

Now select the Paper tab and set the Paper size to the size label you want to create. 
Either the Width or Height should match the width of supply loaded in your printer.

FIGURE 1 Page Setup dialog box, with 
Margins tab selected

FIGURE 2 Page Setup dialog box, with Paper 
tab selected
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7. Label Design

7.1 Text Boxes
Text boxes let you position text anywhere on a document. They can have borders and be 
filled with color, or have no borders and be transparent. They’re ideal for grouping text 
and graphics. You can format text within the text box to the size and style you choose. 

Add a text box by clicking Insert on the Word toolbar , then click 
Text Box. A menu appears displaying several text box templates. 
Click Draw Text Box  at the bottom of the menu 
, then draw a square on the blank page where you would like the text 
box to appear. 

A text box with eight small boxes (handlebars) along its border 
appears at the location you clicked. You can begin entering text 
immediately. The text box expands as you enter text.

7.1.1 CHANGING TEXT BOX SIZE
The “handlebars” let you change text box size. Click on a handlebar and drag it until the 
text box is the desired size. Dragging a middle-top or middle-side handlebar changes the 
width or height of the text box. Dragging a corner handlebar lets you change width and 
height simultaneously. 

NOTE: Pressing the Shift Key while dragging a corner handlebar changes a text box’s 
width/height proportionately. 

FIGURE 1  Text box with 
eight “handlebars”

FIGURE 2 Text box lengths and 
widths can be changed by dragging a 
handlebar until the text box is the size 
you want.

FIGURE 3 Text boxes can be resized proportionately by 
holding down the Shift Key while dragging a corner box 
(handlebar). This text box is being enlarged by dragging a 
corner handlebar while pressing the Shift Key.
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7.1.2 POSITIONING TEXT BOXES
To position a text box on a label canvas, place the cursor anywhere along the text box’s 
border, but not on a handlebar. Your cursor will become a 4-headed arrow. You can now 
drag the text box to another location. 

If you don’t want the text box border to print on your label, double-click on a corner of 
the text box. A Format tab opens on your computer’s menu bar*. Click Shape Outline 

, then select No Outline from the options that appear. 

*Describes Word 2007 or Word 2010 procedure

The text box border disappears.

NOTE: If you choose not to use a text box for your text, you will still be able to print your 
label, although you will not be able to move your text or graphics freely. Consult your 

FIGURE 5 Click Shape Outline from the Format tab, then 
No Outline.

FIGURE 6 Text box with its border removed

FIGURE 4  Placing your cursor along a text box 
border creates a 4-headed arrow.  
You can now move the text box by dragging it with 
your mouse.
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LABEL DESIGN

7.2 Graphics
To insert a symbol on your Word document, select 
Picture from your Insert tab, browse for the symbol 
you want to add, select it, then click Insert .

The symbol now appears on your Word document. 
Move and resize symbols as necessary.

NOTE: Graphic Products provides you with 
industrial safety symbols in the DuraLabel PRO/
PRO 300 Templates and Symbols folder on your 
DuraLabel PRO/PRO 300 CD. Run the CD, then 
click on Install Templates & Symbols on the 
DuraLabel PRO/PRO 300 Startup Screen that opens. You can store the Templates and 
Symbols folder in any convenient location on your computer.

HINT! When determining a symbol’s size, make it large enough to be recognized from a 
reasonable distance and check regulatory requirements to ensure compliance.

To freely position an image or symbol, right-click on it and select Format Picture from 
the context menu that appears. Select the Layout tab on the Format Picture dialog box 
that now appears and choose the “In front of text” text wrapping option.

FIGURE 1 Access Templates and Symbols by 
clicking the Install Templates & Symbols button 
on your DuraLabel PRO or DuraLabel PRO 300 
Startup Screen.

FIGURE 2 Context drop-down menu, 
with Format Picture selected

FIGURE 3 Position an image on a document by choosing 
“In front of text” from the Format Picture dialog box.
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7.3 Merging Information, Sequencing Labels
Follow these steps to effectively create and efficiently organize labeling projects.

7.3.1 CREATING AN EXCEL SPREADSHEET
Successful labeling projects often involve merging Microsoft® Word and Excel 
documents to produce well-coordinated, sequentially organized groupings of labels.

Start by opening an Excel document, placing column headers in the first row (Fig. 1). 
For this example we use Part Numbers and Descriptions (Fig. 2).

A. Enter your first two sequential numbers in cells A2 and A3 (Fig. 3). Select cells 
A2 and A3 and place your cursor over the little box in the lower-right corner of the 
selection. Your cursor becomes a “+.” Now click and drag the selection down the 
number of cells equal to the number of labels in the sequence (Fig. 4).

B. All the column’s numbers will sequence the same as the sequence used in the first 
two rows (Fig. 5). This example reflects 10 labels, with a sequence of 1. 

C. Now enter the data for Column B, e.g., Descriptions, that relates to the data in 
corresponding rows of Column A (Fig. 6).

FIGURE 1 Blank Excel document

FIGURE 2 Excel document with headers 

FIGURE 4 … then drag your 
cursor the number of cells 
equal to the total number of 
labels in your sequence.

FIGURE 3 Enter two rows of 
numbers … 
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D. When all your data has been entered in the Excel spreadsheet, name and save 
your document in a location where you can easily find it. Consider placing it in a 
folder with other project documents. Close your Excel document after naming and 
saving it. You’ll come back to it shortly.

E. Now open the Word template you want to import your Excel data into. In Figure 
7 the static text “Part Number:” and “Description:” are already typed in. Now place 
your cursor where you want to insert your data.

F. Select the Mailings tab from the Word menu bar, then click on Select Recipients 
and Use Existing List (Fig. 8) from the drop-down menu. A Select Data Source 
window appears (Fig.9).

G. Locate and click the Excel spreadsheet you just saved using the Select Data 
Source window (Fig. 9). A Select Table dialog box appears (Fig. 10).

H. Highlight and click on the Excel Spreadsheet page where your data is located, e.g., 
Sheet 1, on the Select Table dialog box. The Select Table dialog box closes after 
making your selection.

Figure 5  The spreadsheet 
reveals plans to print 10 

labels, with Part Numbers 
sequenced by 1

Figure 6 Enter data under 
Column B that relates to the 
data on the corresponding row 
of Column A. 

FIGURE 7 Word document ready to receive 
data from an Excel spreadsheet

FIGURE 8 With the Mailings tab selected, 
click on “Select Recipients,” then “Use 
Existing List” from the drop-down menu 
that appears.

FIGURE 9 Navigate the Select 
Data Source window to access your 
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FIGURE 10 Select the Excel sheet 
number where your data is located 
from the Select Table dialog box. 

FIGURE 11 Press the bottom half 
of the Insert Merge Field button to 
display column header names.

FIGURE 12 Word document ready to receive 
data from Excel Column A.

I. Now click on the bottom half of the Insert Merge Field button on your Word 
toolbar (Fig. 11). The names of your column headers will be displayed.

J. Select Column A header. A Column A space-holder (<<Part_Numbers>>) appears 
next to the Column A header (Fig. 12).

K. Select Column B header. A Column B space-holder (<<Descriptions>>) appears 
next to the Column B header (Fig. 13).

L. Select Preview Results from the Word toolbar. A View Merged Data window should 
appear (Fig. 14).

M. With the Go to Record set at 1 (Fig. 15), the first label in a sequence should now 
appear on the Word template. 

FIGURE 15 First label in the sequence, populated with 
content imported from an Excel spreadsheet. 

FIGURE 13 Word document ready to receive data 
from Excel Column B.

FIGURE 14 Click Preview Results 
to display View Merged Data 
window.
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N. Click on the Next Record arrow to display the next label in the sequence (Fig. 16). 

O. Click the Finish & Merge button, then click Print Documents from the drop-down 
menu that appears (Fig 17). 

P. A Merge to Printer selection box appears, offering the option of printing all labels, 
the current record, or specifying a range (Fig. 18). Check the appropriate button.

Q. Now select a DuraLabel Printer from the Print dialog box that appears (Fig. 19).

FIGURE 16 Click Next Record arrow 
to display the next label in the 
sequence.

FIGURE 17 Click Print Documents from the Finish 
& Merge drop-down menu to start the process of 
printing sequenced labels.

FIGURE 18 Select which labels you wish to print 
from the Merge to Printer window.

FIGURE 19 Select the DuraLabel Printer you want 
to print your sequenced labels with from the Print 
dialog box.
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FIGURE 20 Check for errors before printing your labels using 
the Auto Check for Errors tool.

FIGURE 21 The Checking and Reporting Errors 
window lets you decide how and when you want 
to receive error messages.

FIGURE 22 Your labels are displayed in sequence prior to printing.

R. If you want to save a separate completed merged document containing every page 
in a single file, select the Auto Check for Errors button under the “Mailings” tab 
(Fig. 20). 

S. A Checking and Reporting Errors window now appears. Leave the second 
option selected and click OK (Fig. 21). Your labels are then displayed on a single 
document for your review (Fig. 22).

T. View your labels in sequence on the Word display that appears. If they are ready to 
print, go to File, then click Print. Your labels print as they appeared.
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8. Cleaning and General Maintenance

IMPORTANT! Always turn the printer OFF before cleaning, performing  
maintenance or loading supplies. Always wait at least 5 seconds before turning  
the power back ON.

Basic cleaning of print head, cutter and platen roller will prolong the printer’s life and help 
produce crisp, clear labels and signs. Refer to Section 2.1, Printer Parts, for additional 
cleaning and maintenance information. You can also view a DuraLabel PRO/PRO 300 
cleaning video by visiting DuraLabel.com/duralabel-pro-300/dlp300-support.php.

8.1 Print Head

Figure 1 The print head includes the entire metal bar that sits under the printer cover.

A. Open printer cover and remove any supplies.

B. Remove the rewind spindle, placing it out of your way.

C. Place a cleaning swab between your forefinger and thumb and squeeze until it 
snaps. Alcohol will be distributed to the cotton side of the swab.

D. Run the swab back and forth across the print head several times to remove any 
built-up adhesive, ribbon residue or dust particles.

E. E. Clean the front and underside of the print head.

Figure 2 Clean the entire area outlined in white.
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8.2 Cutter

A. Open the DuraLabel PRO/PRO 300 cover.

B. Rewind any loaded supply away from the cutting mechanism.

C. Place a cleaning swab between your forefinger and thumb and squeeze until it 
snaps. Alcohol will be distributed to the cotton side of the swab.

D. Run the swab back and forth across the cutting mechanism several times to 
remove any buildup of labeling adhesive.

8.2.1 CLEANING CUTTER FROM THE INSIDE

NOTE:
from the printer. An advanced cutter cleaning guide is available by contacting Technical 
Support.

A. Using both hands, gently lift the cutting mechanism from the printer. Wires will still 
be connected, so avoid pulling the cutting mechanism too hard or too far from the 
printer.

B. Place a cleaning swab between your forefinger and thumb and squeeze until it 
snaps. Alcohol will be distributed to the cotton side of the swab.

Figure 3 Cutter mechanism (detachable face in front)

Figure 4 Printed label opening
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C. Run the swab back and forth across the cutter several times to remove any buildup 
of labeling adhesive. Wait a few seconds for the alcohol to dry.

D. Replace the cutting mechanism, inserting the tabs on the sides of the cutter, into 
the slots as shown below.

NOTE: Replace wires through the open slot from where they’re connected, being 
careful not to pinch them.
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Black Tabs

Figure 6 Platen roller

8.3 Platen Roller

A. Remove the platen roller by squeezing the black tabs on either side and lifting up. 

B. Place a cleaning swab between your forefinger and thumb and squeeze until it 
snaps. Alcohol will be distributed to the cotton side of the swab.

C. Run the swab back and forth across the platen roller several times to remove any 
buildup.

D. Replace platen roller.

E. Let the platen roller dry for a few minutes, then reload ribbon and supply. Your 
DuraLabel PRO/PRO 300 is now ready to use.

To maintain optimal performance, the DuraLabel PRO/PRO 300 printer should be 
cleaned after every two rolls of supply. The print head, cutter mechanism and platen 
roller should be cleaned with alcohol swabs to remove buildup of adhesive, dust and 
other substances. Always turn the printer OFF before cleaning, performing maintenance 
or loading supplies.

NOTE: Visit DuraLabel.com/duralabel-pro-300/dlp300-support.php to view proper 
cleaning procedures.
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9. Troubleshooting
The following solutions address some of the most common printing challenges. Please 
call Graphic Products if your problem is not discussed here.

9.1 LED is Solid Red

Possible Cause: Cover is not latched properly.

Solution: Turn printer off. Open cover all the way, then slowly close it. Press firmly on 
front corners to ensure both latches are secure.

9.2 Printing Suddenly Stops and LED Blinks Red

Possible Cause: Printer is out of ribbon or label supply.

Solution: Replenish ribbon or label supply.

Possible Cause: Ribbon spindles are loaded backward.

Solution: Ensure ribbon spindles are facing in the right direction. The spindle flanges 
should be on the right side of the printer. Refer to Section 2.3 for detailed ribbon-loading 
instructions.

Possible Cause: Media sensor error occurred.

Solution: Re-initialize the media and gap sensor:

A. Turn power OFF and wait 5 seconds.

B. Hold down the Feed button and turn the power ON.

C. After the LED blinks red three times in a row, release the Feed button.

D. If this doesn’t work, cover the media sensor with a strip of supply that’s less 
transparent so the sensor “sees” the media.

9.3 LED Quickly Blinks Red

Possible Cause: Power was cycled too quickly.

Solution:
A. Turn power OFF.

B. Verify you are using the correct power supply. “Power supply for DuraLabel PRO/PRO 
300 ONLY” should be marked on the brick.

C. Wait 5 seconds.

D. Turn power ON.
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9.4 Printing Stops while Printing Die-cut Labels and  
LED Blinks Red

Possible Cause: Gap sensor has not been initialized.

Solution: 
A. Turn power OFF and wait 5 seconds.

B. Hold down Feed button while powering printer ON.

C. The LED will blink red 5 times, amber 5 times, green 5 times, green/amber 5 
times, then red/amber. Release the Feed button when the LED starts blinking red/
amber. The printer will feed supply as it calibrates.

9.5 LED Blinks Green after Label is Printed

Possible Cause:  Supply has been paused. Feed button was pressed during printing.

Solution: Press the Feed button again to resume printing.

9.6 After Printing a Label, Printer Dispenses Extra Supply  
and LED Blinks Red

Possible Cause: Printer is set to “Labels with Gaps,” while loaded supply is continuous 
feed.

Solution: 

A. Open the Devices and Printers folder.

B. Right-click on Graphic Products DuraLabel PRO/PRO 300.

C. Select Printing Preferences.

D. Select the Stock tab.

E. Under Media Settings, change Type to Continuous.

F. Click Apply, then OK.

9.7 Printing is not Aligned Correctly

Possible Cause: Adjustable label guides are not securing supply properly.

Solution: Move guides toward each other to secure supply.
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9.8 Printing is Streaked

Possible Cause: Ribbon was installed with too much 
slack or was not centered, creating  
a crease in the ribbon.

Solution: Remove ribbon from rewind spindle and 
remove spindle. Load empty tube onto rewind spindle 
and place it back onto printer.

Possible Cause: Printer requires service.

Solution: Contact Graphic Products.

9.9 LED Blinks Amber and Red

Possible Cause: Unrecognized supply error occurred. 

Solution: Turn printer off, wait 5 seconds, then turn printer back on. Print several labels. 
If error persists, contact Tech Support at 800.788.5572.  

Possible Cause: Specialty supply may be loaded improperly or may be missing the clear 
media cartridge.

Solution: Contact Graphic Products.

Improperly installed ribbon can cause 
labels to streak.
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9.10 Printer Cuts Labels Off-Center or into Next Label

Possible Cause: The print driver is set to print continuous feed supply, while the printer 
is loaded with “labels with gaps” supply.

Solution:
A. Open the Devices and Printers folder.

B. Right-click on Graphic Products DuraLabel PRO/PRO 300.

C. Select Printing Preferences.

D. Select the Stock tab.

E. Under Media Settings, change Type to Labels with Gaps.

F. Click Apply, then OK.

Possible Cause: Feed Offset is not on correct setting.

Solution: Adjust Feed Offset to correct setting.

Adjust Feed Offset to a setting where printer cuts die-cut or 
B Mark labels correctly. The 0 default setting works best for 
most label supply.

Die-cut and B Mark labels cut correctly (l) … and cut off-center (r)
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10.1 Printer

Type: Thermal Transfer

Print Speed (DLP 300): Selectable, 2" or 3" per second

Print Speed (DLP): Selectable, 2" – 5" per second

Resolution (DLP 300): 300 dpi

Resolution (DLP): 203 dpi

Maximum Print Width: 4"

Maximum Print Length (DLP 300): 56"

Maximum Print Length (DLP): 118"

Ribbon Capacity: 984'

10.2 Indicators and Buttons

Indicators: LED (Green, Amber, Red)

Buttons: Power and Feed

10.3 Communication Interface

Communications: USB v1.1, RS-232C (max. baud rate 19,200 bps) and Centronics

Memory: 2MB flash memory, 8MB DRAM

10.4 Power Requirements

Input Voltage: Switching power, 100 – 240 VAC, 50 – 60 Hz

Output Voltage: 24 VDC

Circuit Protection: 3.75A maximum

10.5 Environment

Operating Temperature: 41º F – 104º F (5º C – 40º C)

Operation Humidity: 25% – 85% non-condensing

Storage Temperature: -4º F – 122º F (-18º C – 50º C)

Storage Humidity: 10% – 90% non-condensing

Ventilation: Free air movement
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SPECIFICATIONS

10.6 Label Supply

Type: Continuous, B Mark and Die-Cut

Width: 0.5" – 4"

Gap Height: 0.12" 

B Mark Height: 0.12"

10.7 Ribbon Supply

Type: Wax, Wax/Resin, Resin

Capacity: 984' with 1" core

10.8 Printer Body

Dimensions: 8.4"W x 12.4"D x 7.4"H
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